
GEOPLOT INSTALLATION NOTES               v4 
 
 

Geoplot USB Dongle 
 
The Geoplot USB dongle in this package is programmed to run both Geoplot 3.00 and Geoplot 4.00. You 
can install the Geoplot code on as many computers as you like but the program will only run on the computer 
that has the dongle plugged in.   
                              WEE/GA0052TQ 
 
A short USB lead is provided for dongle strain reli ef and helps avoid damage to the dongle when insert ed into a 
USB port. Please use this at all times.  
 
The USB dongles are HID compliant and so do not require a driver installing. When you plug the dongle into the USB port 
the LED should flash momentarily and a message similar to: “Found New Hardware: USB Chip, Human Interface Device” 
will be displayed. The dongle may be used on 32 and 64 bit systems from XP to Windows 10. 
 

Geoplot 4.00 
 
The latest code for Geoplot 4.0 can be downloaded from our website. Please navigate to the Download page and look in 
the “Geoplot 4.0 – Latest Code – Matrix USB dongle protection ONLY” section. The download includes code, interim 
documentation and latest data sheet. If you have just purchased this dongle then you will also have been emailed a 
DropBox link to the code. 
 
The website will be updated as new builds become available. However, before the website is updated, a DropBox link to 
any new builds will be emailed to those users who are registered as Geoplot 4.0 users. We suggest you make backup 
copies of downloaded files in case our website shou ld become temporarily inaccessible or Dropbox links  no 
longer work in the future. 
 
To ensure you are notified of the latest builds or documentation changes please provide us with your e mail 
address, and also those of colleagues who may be us ing Geoplot 4.00. 
 
Please note that European users should change their computer Regional Settings: 
(a) Decimal Symbol must be “.” rather than “,” (comma). 
(b) Digit Grouping Symbol is a comma.   
Otherwise Geoplot 4.0 may not be able to function properly, especially Import and Export. 
 
If you are new to Geoplot then you may benefit from following the tutorial in the “Geoplot 3.0 Manual” since this will give 
you a good idea of the structure of Geoplot 4.0. There will be slight differences but it should give you a basic grasp of the 
underlying concepts of grid, composite and master grid. You will not be able to follow all the tutorial since some features 
such as Publish are not included in Geoplot 4.0. The manual is available from our website in two parts but is also installed 
with Geoplot 4.0, accessible by clicking on the ‘PDF Manual’ button on the top horizontal toolbar and select either 
“Geoplot 3.0 Processing Reference” or “Geoplot 3.0 Manual”, depending on your requirements. 
 

Geoplot 3.00 V  
 
The latest code for Geoplot 3.00 can be downloaded from our website. Please navigate to the Download page and look in 
the “Geoplot 3.0 – Latest Code and Drivers” section. Select “Matrix USB and Matrix LPT Hardware Lock Protection” and 
on the next page select “Full Installation Code”. The download includes code and pdf manual in two parts. Copy the 
manual parts to the desired location. 
 
Geoplot 3.00 V will work on Windows 98SE, ME, 2000, XP, and 32bit versions of Vista, 7 and 8. It will NOT work on 64 
bit versions – see accompanying documentation for w ays around this problem . Before installing this version of 
Geoplot please uninstall earlier versions using the Geoplot Uninstall program.  

Please note that European users should change their computer Regional Settings: 
(a) Decimal Symbol must be “.” rather than “,” (comma). 
(b) Digit Grouping Symbol is a comma.   
Otherwise Geoplot 3.0 may not be able to function properly, especially Import and Export. 
 
Please ensure a valid printer is installed before running Geoplot 3.0. 

There are several additional facilities included in Geoplot Version 3.00 V that have not yet been described in the manual: 



• Periodic Filter can now be applied to a band of frequencies so you can leave it to process a batch of 
frequencies instead of having to type in a new frequency each time.  

• Toolbar shift setting that allows you to correctly position the toolbars on screen when using some installations 
of Windows 2000 or XP. This is found in Options, Environment, General tab. 

• Animation facility on the Graphics menu. This allows different views of one data set, or indeed several data 
sets from different instruments over the same area, to be visually compared. 

• Wallis filter on the Process Toolbar and Process menu. This provides histogram equalisation that emphasises 
low value readings and compresses high value readings. 

• Export in Spreadsheet format added to Export on the File menu. Data can be exported into Excel. 

• Export pseudo-section in Res2dinv format added to Export on the File menu. This third party program provides 
inversion facilities using the least mean squares method and is available for free download in a limited 
functionality demo version. 

• Download facilities for the new Geoscan Research MSP40 Mobile Sensor Platform added. 

• Shift facility added for dealing with alpha and beta data from the MSP40. 

• Extended Merge Comp facility to include Grad601. 

• Extended the scope of some functions on the Edit menu. 

• Merge facilities provided for combining MSP40 alpha and beta data sets whilst retaining crispness. 

• Help panel added to provide guidance on importing non-standard data sets. 

• Code changes to provide Vista support. This overcomes printing problems in earlier versions by providing an 
optional means to omit display of the Printer Dialog Form. See ‘Running Geoplot 3 on Windows Vista.pdf’ on 
the installation CD for further details. 

 

Running Geoplot 3 on 64 bit platforms                     Version 7     7/2/2013 
 
General Requirements 

You will require a 32 bit version of Windows 8, 7 or Vista to directly install and run Geoplot 3 on - it will not install or run 
on 64 bit versions.  If you have a 64 bit version of Windows 8, 7 or Vista then there are two approaches that can be 
taken – dual booting or using a virtual environment and install a 32 bit operating system on it. 
 
Firstly you can consider creating a dual boot system with a 32 bit version of Windows such as XP, though this approach is 
quite technical so only confident Windows users should try this. Dual booting with Windows 7 32 bit is easier but still 
requires some technical expertise.  
 
Secondly, you can use the latest version of the free (to non-commercial users) VMWare Player 5.0 (test done on Build 
812388) to create a virtual environment in which you can install a 32 bit operating system such as XP (earlier versions of 
VMWare Player did not appear to work when trying to connect USB devices). We are led to believe that the XP Mode 
offered as part of 64 bit versions of Professional, Ultimate and Enterprise Windows 7 can also be installed in VMWare 
Player. We understand the paid for VMWare Workstation can also be used to load an operating system and run Geoplot 
on. Note that the Virtual PC2007 and XP Mode offered as part of 64 bit versions of Professional, Ultimate and Enterprise 
Windows 7 do not allow Geoplot to run due to problems with its handing of USB devices. Windows 8 Professional offers 
an add-on virtual environment called Hyper-V which might also be used in place of VMWare though this has not been 
tested. 
 
You will require a USB dongle protected version of Geoplot – earlier versions of Geoplot protected with an Az-Tech LPT 
dongle or Software Authorization will not operate. You should also be installing the latest version of Geoplot 3, version 
3.00u, or later.  

 

Running Geoplot using VMWare Player 

You can download VMWare Player 5.0 from : 

https://my.vmware.com/web/vmware/free#desktop_end_user_computing/vmware_player/5_0 

 

or search for VMWare Player download. Install VMWare Player, choosing to also install VMWare Tools at the same time. 
Once installed select Create a New Virtual Machine – you will require a legitimate copy of a 32 bit operating system such 
as XP (or possibly XP Mode). Follow the instructions for installing the operating system and then open the virtual 
machine. There will probably be a couple of warnings, one about 64 bit operating systems and another about installing a 



virtual floppy disk drive – just click OK. A list of attachable USB devices will be shown as Windows starts up. You can now 
install Geoplot on the virtual machine. Connect the USB dongle and select the Player menu, Removable Devices and 
TechnoData Interware USB-Chip and select Connect to attach the device. 

 

We have not been able to get a built in serial port to work for downloading (possibly later builds may have fixed this 
problem) but if you use an RS232-USB adapter then this will be listed as an installable device for use - you will first need 
to install drivers for it before it is listed and then connect the device using the Player menu. When using an RM85 and 
USB connection for downloading data then drivers for the RM85 need to be installed first. When using XP we found the 
internet search for drivers did not work so you will need a CD with the correct FTDI chip drivers on. These can be 
downloaded from: http://www.ftdichip.com/Drivers/VCP.htm. Select VCP Drivers, Windows, x86 (32 bit) version 2.08.24 or 
later. Extract the zipped files and burn them to a CD. When using XP set the Wizard up to use the CD and not search the 
internet – there will be a double pass of the Wizard as explained in the RM85 manual. 

See the important information given in the next section ‘Data Download’ and setting up Comm Port numbers – this is 
applicable to both RS232-USB adapters and the RM85. Printer drivers do not need to be installed since they are inherited 
from the 64 bit host operating system. 

 

Running Geoplot in 32 bit Windows 

The following discussion is based on tests done using the Ultimate version of 32 bit 7 and Vista. 

There are important notes below that you should follow before attempting to print from Geoplot. 

Installation 

You should be logged on as an Administrator with full control of installations. Install Geoplot following the normal 
instructions.  

If you are using the Aero Theme then once installed you will find that the normal Geoplot ‘world’ icon is not displayed but 
instead is replaced by a DOS type icon – this is due to a Vista bug when used with 16 bit applications with the Aero 
Theme. This does not affect normal operation but you can choose a new icon if you right click on the program icon and in 
Shortcut select ‘Change Icon…’. If you choose to use the Classic Windows Theme then the correct icon should be 
displayed. 

If you are using Vista then you next have to set Compatibility mode (this is not usually required for Windows 7). Right click 
on the program icon and select Properties, then the Compatibility tab. Set this to ‘Windows XP (Service Pack 2) – see 
screenshot below – and click Apply and OK. 

If you have difficulties running Geoplot in Windows 7 then also make the Compatibility setting. 

 

 

 

Running Geoplot 

It is very important that you do not  run Geoplot until you apply a printing setting in Options discussed below. 



When run as usual we have found that Geoplot will print normally but only once. Even if you exit Geoplot and restart 
Geoplot again the same problem exists and you cannot do a further print. However, if you exit Geoplot, change the 
default to another printer, then you will be able to print to this new printer, but only once. You then have to exit Geoplot, 
change back to the previous default printer and again do one print. 

At the moment there is no easy way round this problem. The problem lies with the Microsoft COMMDLG.DLL, which is 
used to display and change the printer properties form during printing. We have not come across a direct way round this 
problem – trying different versions of COMMDLG.DLL does not help. However, we have provided some code changes in 
version U of Geoplot 3 that helps gets round this problem. This uses the fact that if the printer properties dialog box is not 
displayed then you can print as many times as you like. This requires the user to choose and specify the settings for the 
default printer required that you wish to use with Geoplot before it is launched. As well as setting the default printer 
properties in advance, once in Geoplot you should also select the Geoplot Environment Option and uncheck the ‘Display 
Printer Dialog Form’ checkbox. When running Geoplot in other versions of Windows ‘Display Printer Dialog Form’ would 
normally be left checked so that the printer dialog box can be used normally.  

If you have already tried printing with the “Display Printer Dialog Form” checkbox checked then, to clear the problem, you 
will need to uninstall the printer driver, uncheck the “Display Printer Dialog Form” in Geoplot, reinstall the printer driver 
and set that as your default. 

 

Data Download 

Download can be directly into a serial port or via a USB to serial adapter, though not all adapters may work correctly. We 
have done tests on a standard serial port and also with a Newlink USB serial adapter and the adapter we provide with our 
instruments. Other users have found Belkin adapters to work correctly with other versions of Windows though we have 
not tested these on Vista. It is very important to follow the installation instructions for the adapter correctly otherwise it 
may not function – usually the driver is installed before plugging in the adapter. The driver software that accompanies the 
converter will probably assign its virtual COMM port to be a number greater than "1". If using Geoplot 3, you should select 
the Input tab in Environment Options and set “Download RS232 COMM Port” to match this number. (In XP and Vista you 
can check to see what port the converter is assigned to by clicking on Start, Control Panel, System, Hardware, Device 
Manager, Ports – follow a similar route for other operating systems. If the COMM port number is larger than the range 
offered by Geoplot you can change this by clicking on the Port Settings tab, then Advanced). 

If you use a USB converter you will find that you have to exit Geoplot after a download in order to clear data left in the 
adapter's buffer. For example, if you come to dump data and see the message "Receiving data…" instead of the normal 
"Waiting for data…", even though you have not yet pressed DUMP on the instrument, this is a sure sign that data is still 
left in the adapter's buffer. If you do not exit Geoplot at this stage and continue downloading, the data will be scrambled. 

 

 

 

 
 


